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Inside Switch Qutside Switch
.
Load Balancing: == Node1/Control === | ,2d Balancing:
PBR or ECMP : PBR or ECMP
' inside eth1/2 eth1/1 outside etho/0
eth0/0 70.1.1.1 (main) 00.165.201.1 (main) -
10.1.1.2 (local) 209.165.201.2 (local)
inside eth1/2 LYP cth1/1 outside 1/
iy 70.1.1.3 (local) $97500.165.201 3 (local) kb
Node3
sl inside eth1/2 eth1/1 outside -
10.1.1.4 (local) 209.165.201.4 (local) .
Node4
inside eth1/2 _@ | cthi/1 outside -
g 70.1.1.5 (focal) MRS 705,165 201 5 (loca) e
-1.1. G US.102.2U1 .20 {100
D )

N

xR

BT REEHIER

DI %N ES

ANSCREE 2 JRRSIX LK M8 IE -

RO R, B4 ASA #2 SR B B O 1P HuhlFl MAC Hidik. 55T 560 (19 8% i1 (PBR) /&
— AR B T
WEAR T A AR PBR JFA 8 78 00 R FUEAT (W AR B0, FRAT T U HI 7 2%

PBR AR 4 4 B SR I ACL AR H B H S o ISR RE P T H ASA Z RT3kl . HT
PBR &AM, D] BEA NGk SE s £ (1 T B30T R . O TR AR R RE, Ui &
PBR %M, DUEIERE (1) 5 Al B AR [ 2o A0 1) 2[R —A ASA. il Wiy — & JRHS th
A, AT R GURER (1 B TOS PBR BT SEIRTUAR . R 10S X & ERERE H] ICMP ping W54 &
ASA. X5, PBRUTHIEHEE ASA IRV I MK AT P A F 2% ch ks o AT OCTRAIE I, WS BT
URL:
http://www.cisco.com/c/en/us/solutions/data-center-virtualization/intelligent-traffic-director/index.html

http://www.cisco.com/en/US/products/ps6599/products_white paper09186a00800a4409.shtml

R H
{F FHA ST R N, A ASA B O H A (3B A O TP HiliE AT MAC Mk 254 £ 4% (ECMP) % /&
— PSR BRI T

R C AT ECMP I Ay 8278 70 A BT 10 6 Rt e, AT T U I vk
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! Cluster interface mode
cluster interface mode individual
|
! VXLAN peer group
object-group network cluster-peers
network-object host 10.6.6.51
network-object host 10.6.6.52
network-object host 10.6.6.53
network-object host 10.6.6.54
|
! Alternate object group representation
! object-network xyz
! range 10.6.6.51 10.6.6.54
! object-group network cluster-peers
! network-object object xyz
|
! Cluster control link physical interface (VXLAN tunnel endpoint (VTEP) src interface)
interface gigabitethernet 0/7
description CCL VTEP src ifc
nve-only cluster
nameif ccl
security-level O
ip address 10.6.6.51 255.255.255.0
no shutdown
|
! VXLAN Network Identifier (VNI) interface
interface wvnil
segment-id 1
vtep-nve 1
|
! Set the CCL MTU
mtu ccl 1654
|
! Network Virtualization Endpoint (NVE) association with VTEP src interface
nve 1
encapsulation vxlan
source-interface ccl
peer-group cluster-peers
|

! Management Interface Using DHCP

interface management 0/0

nameif management

ip address dhcp setroute

no shutdown

|

! Alternate Management Using Static IP

! ip local pool mgmt pool 10.1.1.1 10.10.10.4

! interface management 0/0

! nameif management

! ip address 10.1.1.25 255.255.255.0 cluster-pool mgmt pool
! no shutdown

|

! Cluster Config

cluster group clusterl

local-unit A

cluster-interface vnil ip 10.2.2.1 255.255.255.0
priority 1

enable noconfirm

!

| INTERFACES

!

ip local pool inside pool 10.10.10.11 10.10.10.14

ip local pool outside pool 10.11.11.11 10.11.11.14
!
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interface GigabitEthernet0/1

nameif inside

security-level 100

ip address 10.10.10.10 255.255.255.0 cluster-pool inside pool
|

interface GigabitEthernet0/0
nameif outside
security-level O

ip address 10.11.11.10 255.255.255.0 cluster-pool outside pool
|

'JUMBO FRAME RESERVATION for CCL MTU
jumbo-frame reservation

HIETH S Day0 EL B

R LU Day0 FC BRSSP RCE . RSO s 8 A I 1Y 10 Day0 BC & P 5k
fE

\ )

IR JACE S UEREA LA E . Day0 it BN AFEVF AT . SSH TR . ASDM Vi [a] 55 At 152
A% Day0 BUE MR R, SRR

I'BOOTSTRAP

! Cluster interface mode

cluster interface mode individual

|

! VXLAN peer group

object-group network cluster-peers
network-object host 10.6.6.51
network-object host 10.6.6.52
network-object host 10.6.6.53
network-object host 10.6.6.54

|

! Alternate object group representation
! object-network xyz

! range 10.6.6.51 10.6.6.54

! object-group network cluster-peers

! network-object object xyz

|

! Cluster control link physical interface (VXLAN tunnel endpoint (VTEP) src interface)
interface gigabitethernet 0/7
description CCL VTEP src ifc

nve-only cluster

nameif ccl

security-level O

ip address 10.6.6.52 255.255.255.0

no shutdown

!

! VXLAN Network Identifier (VNI) interface
interface wvnil

segment-id 1

vtep-nve 1

!

! Set the CCL MTU

mtu ccl 1654

!

! Network Virtualization Endpoint (NVE) association with VTEP src interface
nve 1

encapsulation vxlan
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source-interface ccl

peer-group cluster-peers

|

! Management Interface Using DHCP
interface management 0/0

nameif management

ip address dhcp setroute

no shutdown

|

! Alternate Management Using Static IP

! ip local pool mgmt pool 10.1.1.1 10.10.10.4

! interface management 0/0

! nameif management

! ip address 10.1.1.25 255.255.255.0 cluster-pool mgmt_ pool
! no shutdown

|

|

Cluster Config
cluster group clusterl
local-unit B
cluster-interface vnil ip 10.2.2.2 255.255.255.0
priority 2
enable noconfirm
|
! INTERFACES
|
ip local pool inside pool 10.10.10.11 10.10.10.14
ip local pool outside pool 10.11.11.11 10.11.11.14
|

interface GigabitEthernet0/1

nameif inside

security-level 100

ip address 10.10.10.10 255.255.255.0 cluster-pool inside pool
|

interface GigabitEthernet0/0

nameif outside

security-level O

ip address 10.11.11.10 255.255.255.0 cluster-pool outside pool
|

! JUMBO FRAME RESERVATION for CCL MTU

jumbo-frame reservation

MBS F ASA Virtual &£ 2%

BAEERE ASA virtual JElCE ERE, ERATLL NS .
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FERCHE B0 1R FHARE IR, 22 iy G 0K 0 o DA T 4 ) 20 B TG
B A i) A B G B A B B T AR A

FiaZ Hl
FERFR B AT

mEEEE ASA Vinual £t ]
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BRREREORE
BB BERE TR, BUSAERE I BB T S S AR T B S 2
BT R, AR 1| SR R R AT R

T s LR EEFHEOER

FEJG HIERAE AT, 15 2R B KB HAt R AT BN 1o AR BRI nT U] e 1 7,
DI R S VR A B B R S AAAEA A AL D, R e PR R B AT AN SRR3R

)

AR RS S AN WA R A AR AT Y L BT A B R B, AU R

UK

FIE 1 LEFEHI A ASDM H, K IREFET B (Tools) > A5 €1T#£ 0 (Command LineInterface). & ~fE{]
AHEA RIS, DMERY G b v e OB HE ERCE s 2B S B LA iy 4 1 5 0

cluster interface-mode individual check-details

IR
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LeSTRAAY

[ ] [ ] Command Line Interface

Type a command to be sent directly to the device. For command help, type a command followed by a question mark. For commands that would
prompt for cenfirmation, add an appropriate noconfirm eption as parameter to the command and send it to the device. To make the changes
permanent, use the File > Save Running Configuration to Flash menu option to save the configuration to flash.

Command

© Single Line Multiple Line Enable context sensitive help ()

cluster interface-mode individual check-details

<

Response:
Result of the command: “cluster interface-mode individual check-details"

ERROR: Please modify the following configuration elements that are incompatible with ‘individual' interface-mode.
- A cluster IP address pool must be specified on interface Gil/1l(outside). Or remove IP address configuration.

- A cluster IP address pool must be specified on interface Gil/2(inside). Or remove IP address configuration.

- IPVE autoconfig is configured on interface Gil/2(inside).

- DHCP Client cannot be enabled on interface, Gil/3(dmz1l)

- DHCP Client cannot be enabled on interface, Gil/4(dmz2)

Clear Response

Help Close -

FE WEBEOMAZ G, L 4k a0, (B, W e 7efic & 5 B Dl 1A & 4
FEER (B ans InSEBE 1P b sl )\ DHCP kX 1P #hhl) 2 AT E gk ASA, WK Gk &
WO, DU SR O BCE CMBR . (RSO0 T, B 0% 2450 5 o
CHnR v HD KRB S ORE .

PB2 R E R R
cluster interface-mode individual force

=l
B 2igEROE.

[ Command Line Interface x
|

| Type a command to be sent directly to the device. For command help, type a command followed by a question mark. For commands that would prompt for confirmation, add an appropriate neconfirm option 25 parameter to the command and
send it to the device. To make the changes permanent, usz the File > Save Running Canfiguration to Flash menu option to save the configuration to flash.
Command

(D single Line @) Mukiple Line Enable context sensitive help (7)

| |c1uster interface-mode individusl force

Response:
Result of the command: "cluster interface-mode individual force"

WARNINC: Cluster interface-mode is changed to 'individual' without validating compatibility of the running configuration. Please make sure to resolve all remaining configuzat

< >

Cear Response

Com ] om [ e

AFAEBRN BRI P I R R B BRI, TR 8 T AERE
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for ce it 1 n] 1 #2% 5F SSOB i e A B L B P R BAAAEA MR E . Fials, BHETEEE
ARAT P ) T AT e OV RC B ReAE B Se S E R,  RIL IR AT LAl ] forcedB I, IXAF
RO NI ESE T BEERA)G, B LLEBHZELT check-detail sIE TR 3RS B £ 5% (5 Hl.

WUR AL forceik I, UIEAEA R AFA A EIN, RICUPIREERECEIFTET Mk, N
WIERIEEI G O CnE T D Sk ECE S Y. BRI EES A ER) , W
HR IR EICE . RS TERICE, WPl n i EH G4

SRR RS, M no cluster interface-mode 74> .

$IE3 HH ASDM IFEFi N . ASDM 75 E 887 i3 sh A GE IEM MR E i i, Ehrnds, T bk
7% ASA Cluster I :
3: ASDM EEF 3
Device Information
General ASA Cluster virtual Resources License

Cluster Interface Mode: Individual Interface
Cluster is not enabled.

FEEFIT R LR B R RHTHI R

EIBAT I S22 00, AR R O E — A VXLAN #1105 ¢ VXLAN FIAE BERS B BE IR (1 7F
M5 R, HSRERETIRER , 564 0.

FHia Z |l

Jet BRI B DA T Atk i, DU n] DR A Pt B Bk MTU BB B . 3 F By
S5 ASA T INE. AFBE (Configuration) > % &i& & (Device Setup) > & & (Interface
Settings) > ## 0 (Interfaces) b %

)

AR AR T R R R T B

UK

B YU R0 G P VXLAN PRI 280 (VTEP) %2544 1P Hbudik.

ML R A TEAE S, 152 B E (Configuration) > B A3 (Firewall) > 3F % (Objects) > W
433 % /4B (Networ k Objects/Groups) TUTf, LA ASA Bi KESHCE 8RR ) “ Uiyl 4”7 —i,
VTEP 2 [8] )3l TP W Z8 M7 T VXLAN W5 bR T (VNI $22 28 SRR R BE RS I 2% o R
VTEP P4 AE TR _ LA N 1P Huhik. b7 RN 5 Br HoAth iR B Fg 2, JF H R ARG a6
BEERFEI,

B AsasmmEsen
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R e T P |

$1E2 W'E VTEP Y511,

VTEP J5#5 o — /M RIEEIL S VNI HAH ORI (1) H A SA virtual #2110 LLK—A> VTEP J
PR E A SR S . W IR, DA A4 B s s o
a) WUEHEE > ®&RE > BOKRE > #0O, AEELH T VTEP Y8 8.
b) Mt EIEORZFR (Interface Name).
c) %+ VTEP DO (VTEP Source Interface) & 1EHE.
d) EhERED.
e) MLEERA IPv4 bk,
1P Hl bk W A g 0 SR 2 — S e I g R S o
f) fiitim% (Advanced) EIR, SRJE¥ MTU B8 b 82 O (1 s MTU 2705 154 275,

H T AR T e i R B 0 R, DRI LG R A 42 T 1 e e 008 5 4 e B /N R i £ DA K
SEREREITRY (100 F75) M VXLAN JFRY (54 F45) o B MTU BB 4 1554 5] 9198 7752 [
PE . BRIA MTU 4 1554 “F05 . 88 & & 1500 B, FRATE SO R T BE M MTU %
BN 1654; AT EEMITIR, i 7SR .

Bltn, e B, BT s MTU b 9198 45, IR KB 10 MTU A] LU 9044,
A RES BB AT LA S BN 9198,

g) MHHAE (OK).

¥ VTEP ¥ O 5 W 4% ik 2 (NVE) SEFIAH IR .

a) WKUGEHEE > K& RE > #EOIRE > VXLAN.

b)  CAfEk) R T L BRIAE 4789, if A VXLAN B#risH (VXLAN Destination Port) 1§ .

c) EHER VXLAN 32 M4 E 4k in & Bk,

d) M FHEFiEPE VTEP Tunnd I nterface.

e) ETEBEHRIEEWH A (Configure Packet Recipient) HikHE, it *tZ54R (Peer Group) Hiki#
Hl, RIGIE B R .
f) i Apply.

A VNI 311,

VNI CIBT VLAN B0 BB, I AR, ST B (et e 1 1
AN (SRR VNLBEL.

a) WUGEREE > IR&RE > EORE > #0, KRG AdERm > VNI Q.
b) AT 110000 Z 7)) VNI 1D,

IE ID A N AR RAT

c) HIAANT 1A 16777215 Z[A] () VNI Segment 1D,
M B ID H-F VXLAN Frid.

d) % NVE Mapped to VTEP Interface & EAE
PR EOR VNI #2115 VTEP Y5 LA G

asa g
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e) MiifE (OK), RnmidiEA (Apply).

JEHERRE 0T, USSR E T IP Muhb B O, AR L IR . AR RS 1P
HuAEREAT A B, ST RE AR D R I ASDM M ERERE R BE 1. BT IMbR 0, AT LR
JIEEREZ B2 Sl s BT BT AT 1, DA S BV L B [ 20 20T A R A 1Y A

AT TR B S AR A AT 1 o BRSZ A PR IE R B e e 1, BN N 1P
MBI AR A O TP okl SRR E AR A 1P MuhL R AR BRI s ik, SR T mr IR s i
GIRER{CiiEAmE DV oy iV Ju

WP REE I, BRI DARCE IP bk, AT DA DHCP; A4 B 1 S £f N DHCP skEG# b,
FAF ] DHCP, 2R, MR EEE GES M E & M b 0250 .
FFi&Z |

o (WHE) ME TR,

o XNFEHE O, Ear UAE A ERASHuaE, nr DAd ] DHCP. 01 S g FERAS TP btk I ] ASDM
TREIERE R B O, WA B T A r 24 a0 1P sk AL I A .

o AN RO AR AR Y R b SRR RE TP b 23 LS — A TP H ik

o SERE IP {0 ANRE AL 75 W4 b /RS R bk, 0 AR B 15 4% 1) TP ik
il
1 KPS A E A 10.1.1.1.
2. HAbATSAE A 10.1.1.20 10.1.1.3 A1 10.1.1.4,

3. (EFEMY R RCE A 1P M, AREAEHBME RS bl 20 3 504, BRI O AR
T

4. Rz, BTEAHZM L HAh P bk, 1.5, .64 .7 AT 8.

N

AR MR R AR RO S RS Y SR N SRR RO A R 1
Sk Je T 2R Y K AR A TP Mk

5. MAGEREZ A, 8] IH bR 55T HIOF al T T e 4k

g2

$IB1 KRR BLE (Configuration) > & &R E (Device Setup) > ##& & (Interface Settings) > ##0

(Interfaces) %%

B AsasmmEsen
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rzztrz0 I

W2 EFEIT, ARG AULYREE (Bdit). ERERERS IP (Use Static IP). ASZHF DHCP 1 PPPoE.
IR 3 LRI IPv4 B 1P . MAC Huhibyth R Sk (1 MAC Huhl, 1% &4 (Advanced) ik iR I %

H ASA £ 8% (ASA Cluster) XIS %,

a) AP kb (1P AddressPool) 7B 551 ... SR G SERE TP Wb, R4 /s A 20 Bl X
YT EHE General JEI-RHH B E (1 F TP sl

b) Adiimin (Add).

¢) MUE MBS, AR 1P Mkl AN RIS R SR A ko et Y RN
XFEEREI /NI H LK, Bl 8 AMthik.

[ NaNs) Add 1Pv4 Pool
Mame: inside_pool
Starting |P Address: | 192.168.1.2 D
Ending IP Address: | 192.168.1.9 [_]
Subnet Mask: 255.255.255.04 :'

Help Cancel Ok |

BHed

d) rili#E (OK) LAEIE B kit
e) EFEAIEMH bk IF AT S B (Assign), 25 mHEHE (OK).

Hotilth 44 #xof s T 1P Address Pool B,

0 (Mg (%) WREETF NS MAC Hhblk, 5EE — MAC Address Pool .
PCE 1Pv6 Hhhk, 18 55 IPv6 EI < .
a) % Enable|Pv6 & iLHE.
b) 7E#EO IPV6 ik (Interface |Pv6 Addresses) X1k, Aidii#in (Add).
AFF IR Attt B h BB L
A0k s Add IPve Address for Interface X EHE

¢) 7t Address/Prefix Length B¢, % A4 IPve Mtk Al IPve Wi . filt,
2001:0DB8::BA98:0:3210/48.

d) Sy e S4TGB SRR TP
e) siiiAN (Add).

enno Add IPvE Pool
Name: inside_ipve_pool
Starting IP Address: 2001:DES::1002 =
Prefix Length: 32

Number of Addresses: al

Help Cancel | OK

aHea
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B srsumimsmsmasEs

) BCEELA IP Mkl (ZEHTEED | ATSIC BRI bkt ik
g) MITHARE (OK) LAGIH B Kbkt .
h) EREAIERFT IO AR S BS (Assign), AR5 rHBRE (OK).

Mkt 2o~ T | P Cluster 1P Pool “ZE¢ .
i) MM E (OK).

LIBS fHHAE (OK) LURFIF] “H2117 (Interfaces) 4% o
W6 midiMNA.

EREA AR SFEESIMNERF

FERER AR Y A 2T 5 S REP OB A REIMASE R . AE CREE BN BRI i) — A bz
AT DR T B G B QoIS 2 S AR b € TR DRy I ESIRE R S

Fi&Z |
o TEIEREMIACHNL b, B FAE R BRI 4 1K) VXLAN VTEP P32 b2 AL T84 IR A
o AT A IR IEAE AT AR, v Re ST PR M i 5 B /W TP %, IX 2 TIIAT A .

i

TE1 EF mS (Wizards) > Sa A4EFAR] B4 ES (High Availability and Scalability Wizard). 123
DL DB AT DCIE B ) IO UEN
1% 2 £ ASA Cluster Configuration bi#EH, ALE S| ST RE, W

© BURILFELR - BEE I mUH T RIE2S A S, HAEVE Y 1 2] 100, L 1 4ot
e

« S E S| (SiteIndex) - U R A T ot s TR AERE,  DUDSE A HE Y A N 1D, DA BB T i 5
RrE ) MAC #iiE (AT 188 ZIRD &

o (gD HEZHA - WENE P USRS R B IR KN T 1A
63 NPT LI ASCIL 745 i o IL= s PR s s . S A M A AR i
AR 2 DL SCRGE I BRIR A SRR AR . Wi RS0 I8 I 1 SR s Ik g%, s 25
BEHSH.

+ (H[#%) Enable connection rebalancing for TCP traffic across all the ASAsin the cluster - i H
R BOATEOLT, IS THERPIRES . WR OB, ASA SRR e A #ie 1 4%
fER, IR MBIBOR B HBT IS RL I B B B . ORI 1 3 360 £, T
58 2 KIN A e R BE R . WS EOFAES | SREFECE 35, M A IS S A2 2
CTRED S I

B AsasmmEsen
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pE s TH2) vl 5 TR 4 C B R P M s AN SRR PRI BT T Rl B
JE D

(A1) Enable health monitoring of thisdevice within the cluster - Jii FIAE RS s TR AK A
Thig. N THAE T IS TIRGL, ASA SERENT RIS TEAERHE HIRE R [FF heartbeat W 5L & 1% 2| HiAth
Ao WU RTAE LRI P A BRI B AR T SR AT A heartbeat T 8L, TUSHAEAT S04 T
i B 5 G 1A%

pE s A R AEAT AT U CB s s R A4 1 T AR ] ASA BAZHAL 11
D, ARSI A, JE A CA IR LK . R0 &
P e i G B e B B sm, BrT LUECH R Rl A RO 2

R EWAAER M Z BT A #5618 (Timeto Wait Before Device Considered Failed) - 8 T
fff 72 15 £ keepalive RSV BV RIBR T[], wIBE Y 3 245 F0; BRIMEA 3 75,

CriE) EHEH At - 8 KT s BEHT SR H G 6. BOAN O N AR )

o X TR RBEEFAIE, ASA W EEEAANH BRI HI G . WREH T sl 6 = H, Adk
TR G W S ROR B A IR SRR N G i 1. kS HOFE
S FRERCE N 8, A AR SR B R

* Cluster Control Link - $& & fER A I BERE B 1

* MTU - f5 € VTEP #2 1 5 K AR 547 28 /b b 3o B2 1 (1) dse sy MTU 57 154 21 TR
R R S EOR e A, DR LS 2 T o 5 2 R A A e M/ N B L L K
R ETITAY (100 775 F1VXLAN JFRY (54 7795 o ¥ MTU & N 1554 #9198 7745
Z IR E . BRI MTU 24 1554 745 o 43l $: LA E N 1500 I, FRATTEE SO S FE 4 1 B ek
MTU % &0 1654; ST EEMWTINEA . Flr, A4H B, B85k MTU 4 9198
1, ki R O MTU o DUE 9044, i SERERS HIBERE I i) DLW B 9198, LS5
HAEG I PR PO E 55, M AT SO By T B SEE WA
A ERMWRE, NIBH S, JHHERW, AR5 F R SR .

$I2 3 1T Interfacesfor Health Monitoring e I, #0] DU Rt — bz O E Tl i b . sl BEARZR TR
FEE L (B R D s RO

pEEd DR S AEAT AT SN s I el B A e 1 R YA T ASA B S L L V4
FD R RIEATIRAS KA, IR SEAEHI AR LR A% . 3 b Sy B
SECHIECE E S ERE B P mUn, B LLEE R Fs RO 2

IR 4 7£ Interface Auto Rejoin settings i 1, [F 52 AR 1 AR TR 1 B A= i s I 1) 1 sh BB A
BOE . X TRERSERY, AT LABCE LR 2L
s RAREFIMANSIRE - 3l BB TR T~ 0 3 65535 HMH, & SCEEBT ISR 2l
O R 25 ABEF I . X AR, BRAME ) Unlimited; Tz b, BRIMED 3.
* EFINERE - W i EAN T2 2] 60 PRI, SO UCEDET AN 22 8] (14 18] [ 55 2 TR

CPAAT R i) o BRIAME 5 8. 5 2R E B N SRR A0 o K R s TR FR AR A B R R
Z W2 14400 2050 (10 D &

asa g
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B crEamtasemsma s

* Interval Variation - @t ¥ & AT 1 2] 3 1 MRIBRARA, @ SR FREFLERT AR B 1 (AR |
2 CLARFFEEEIM 2 f5) 803 CEIRFFLENT I 3 5D o Bdn, o Ak [ b FF Sl i 1) 3
h 5o, IR RSN 2, WITE S R RHTHE 1 IR 76 10 208 (2 x 5) JEHEATER 2 K
Sk 7E 20 0B (2 x 10) JEHEATER 3 sk X TAERE L, BRMEN L TR, R
IEA 2,

HIBS iR
FTIE6 ASAKHARIEAIZITIE, ARERANLFNIIREA AN S, AREEIAECE b o ReELE iy
A ST MR ARG A, Wi S meg, WS S AR,
2t —BNT S, 24 ASDM Ji AR E03nd 82 8] ASA I, RE0K E7R Information JE4s, ffiiA
ASA CNINEIERE,
TR FERLURERUR, SERUn S a I SERE 1T e tHBLAR % . S ASDM Wi JTi%4%, ASDM
ANEWLFR H ASA AT )G 928 . W BHiE R ASDM G SR RAE, Nk s
ASA PG B A 2 25 SERE I FAREER T O, B, SERE I BERS nT BE 2% 1]

TR ERINEIE AL R

U R Y ) EPTEAT T, W RAAE O 21 1) S I UE 5% 1o R B 78 00 L b B SR TIOR8 in i
R

12 8 7F Deployment Options X1, M LLF Deploy By i1 H k£ 1 T :

« STENENBRFZIR & K% CLI 7% - 5| PAPHC B AL B HAR Y AW ORI B39 1P Hudik. B
BRSSP k. FH P AR,

* BHERH CLI FahEH FMMELERERE L - A pkiar 4, DUEST )RS 20800 7 55 CLI 8%
7 ASDM H{fi[f] CLI . H.. 7F Commands to Deploy & iEHEH, MEFE IS HIAE iy 1L RS 5
i

Deployment Options
Deploy By: | Copying generated CLI commands to paste on the remote unit manually 3

Commands to Deploy:

cluster interface-mode spanned force
clear configure cluster
interface GigabitEthernet(/4
no shutdown
cluster group clusterl
local-unit asal0
priority 2
cluster-interface GigabitEthernet0/4 ip 192.168.5.2 255.255.255.0
key test
enable as-data-node- noconfirm

B AsasmmEsen
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arvEszt

= \Y A= B 4D
B ENMEERE
YERNEE 0 RECE )34y, BiEEMEERZ )G, Balbl 8 e VERGSITIRGLEE . TCP EEE H
SEIR . A BRI H AR AL
LR S E AT IX SR .

A EE A ASA £8 5K
BT DAY f b A SCIERFCE . RN 1) SRR T A I 2B R, mT AT Bl e B 4
SH. WARCR SERE, T AGa SRS 0 AR I JoiE g iR i) AL S B I . AR
PR 17 3 AT K S
FiaZ |l

o WEARGEARAT 2, FFAETAIAGERE, W EAE ISR 2 AU AERE AT e TG B A T
HIRERS . 1S PR Y S R AR R RS . 2 14 0L

UK

P KKERFERE > R&EE > S RAMMAT RN > ASA £5.
WA I e ARSI b Ho #7520, LA ks (e S B¥ECE (Cluster Configuration) 3~ |,
$I® 2 % Configure ASA cluster settings & iEHE .,

RO E T I SRAE, BRI BERR . ERCE DT ST, Wik S5 ASA &8 (Participate
in ASA cluster).

iR JE ARG, WEIEA T 85 R B0 R EGH &+ Configure ASA cluster settings 5%
HEo UEHAE VG BRI A SR B OC T A He 1, 4G ASDM B B 1 . 7EllE
LR, BEAERE, AR 6 o 1BV CLL

FE3 BLELL T 5 SRS AL

* Cluster Name- &R 4 . AV AUERKEN 1 3] 38 NFAFFH) ASCIL A48 . BN M A BE
BOE —ANMERE. SRR T R 2 H [ — 44 B

* Member Name - fifl ] M — ] ASCIL 74 # O PLAE I S w44, QL2 1 3 38 77T

* BUSMRSELR - BB U TR RO A IARSE S, FUE T 120100, L 1 il
e

. 15‘5 25| (SiteIndex) - S a4 FH ol s g AR, U5 g b A e Bl s ID, DAL A il
FEEM MAC il (A F 188 208 .

| asa g
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+ (WiL) Shared Key - B8 I o P LU ISR IR T HERE BV E . LMY KN T 1

A 63 ANFAF LI ASCIL 745 i o JEEF P T ARSI E # . WS EA LM S AR
i, EAERIRA DI SORIE R IE RO SR M R n . REIE IR T3 63 g ik 55, il
LB S

(FJ#k) Enable connection rebalancing for TCP traffic acrossall the ASAsin the cluster - J5 H

R BOEOLT, WSEAE TEERPRGS . WS EOTFES | SRPICE R 7, M
P SRR Y SRR R EH . ASA S A A SRR IE NG R, IREEEE
e N FD AR 2 (B35 0 T B S BRI e % o LA IEHOKIEA S8 3. Mo, BT Iy
AEE T RERD AT BB A, DA S B R B LI S, O HE
SECATRETEAAHAE o IR IE R 1 3] 360 #6, HTHaE 2 K A2 — R8s . BHAMA
h 5 Fb.

REERR RPN S5, SR O AR FRE R

TH21 0ok s TR 40 SR G EE B YT SR BORERT IR B 17 BT AN R 3 s X SRR

AR

BB S B EEEE - S nT DU PR SRR Il o U 03, A R B, CPU AT A7 A6 I B0 LA
LM IX EFF e MRSy, LR B T AR B A0 38, 4T DA R AE 1Y il B Tah 2l 4k
BE, B HESNRAC LB Db . BOASOL T B AT Ehae . nT DUS s 8. W
KAt m, BT LOEFET BT B SER

BEELLMME:

« BFE) (B PR — W E PR IR R Z TRl ) CRARD ), JEEEIA T 103 360 #b 2 f0). BRIA
ik 20 ¥

* [BIFREY — BUE ASA HE AR BRECE, T 12 60 21 BRI 30.

W2 %42 (Monitoring) > ASA £ 8% (ASA Cluster) > £ 8# {1 3 445 (Cluster Load-Monitoring)
DAEY B i i 728

(ATk) BRASERNIZIREIEITIRRSE (Enable health monitoring of this device within the

cluster) - J3 AR RUSATIRDUR A D) B8, JEAfE 15 RUKIE heartbeat JRASTH B R 1B ] B,
JWHAT 3345 B2, BOMER 3 8. JEE: EREREP ARG 5 L B ASA SISl
RGN, NIRRT RE, HEISERE GBSk, WA DA D s (BCE
> REEE > SR B > ASA £8 > SEEHEMETRR IR, ErI DAL
PN T e e 5 TR FH IR TR O T #fE 1 RS ATIRI,  ASA BRBE Y RS RS I
1K heartbeat 1 E AL B AT mo U SR RUZE DRI Y AR EIK B 645 4Y AURAE T heartbeat
RN, DNDRE AR AU A T R Y BTG 2 A

CRI3k) B BRAT 8] - FC B ASA K AN A A bR 1 sl IARTRE N Bk 2 i el 1 197 e il
IFIA) . SHE D BE T LIRS P PR B o R, SR C 7 B I [ AT, e 88 i3
ILHR FERARL LRSI, ASA SAERHRE M2 0AL AR5 A K45 DARIC o A B s,
T NS BR . BRI AR S BB ()2 500 2E4%, %I TRV 300 22702 9 75

Cr3E) EHEHI M - KT i B SRR G . BOARTOL T 4R )
AEo X THFERBEFAF, ASA W EHEHICLIH QA MBS & . WA I 7RG W, HdE

B AsasmmEsen
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TR G W B AOR B s, DI R SRR 1N G i 1. ESHOFE
G P RERPRCE K — B, T AR s SR B el s

« (n[#) Enable Clustering Flow Mobility. i&Z: Rl & LISP kil , %5 27 T,

« (A1) EnableDirector Localization for inter-DC cluster - > T 4 & 1tk A FE /b Hedh oo 1k
AU BRI A IR IS T REIR , 0T DUS P I8 A oA o BT Feil i 83T, A sl s Y
ERRE R T o (RS, ASA 3 AT 3l UK A A0 L T 25 AR £ . 3 ] SR A HB AL SO A
a0 5T 3 Rl s A 3 () S A AT R0 S AR T 88 BT 3 R T ) 2
TRl AR T ERE . JIAh, WGP RN, AH 3 () 28 e W B[R] — 3l 0 A
BRI . R R JE T A B B R A, AR T A

o (HHE) SHRITUAR - A ORI Aol fOMRes2 i, ] BUS I mO0AR . W ABER I &0 Tty
BHPATEAL T vl m L RS Aol LR NN &4 B AT 8 R ORI U i S 3
SRR o T ) s A AL A, RO AN DI RE s T ARCE R —AS, sk RCE P

(") BABRERDSINE - 815 Al GG S ECE AN RN, R GUR B CE [P A,

M INBR DI SERF R o BROANG OO T I I DI RE . DI REAEREAN T AL BICE, Ao IFEHIY

s S B EE Y R

iR FHELCE Ay A IR IR W P AR IR Sy 4, R O H s
LR, WAL I E R . OB AR A RS, DU R IMA T
. 1#iH show cluster info unit-join-acceler ation incompatible-config & & AN 25 1
[

* BRFTEEES - o M ml LS B O TREP IR S AW, Rt 17 m 2y,
HF Rl AE TG ZEAL 9 2 N )

o TURTSRIFR R EIZEIBS (Flow State Refresh Keepalive Interval) - 15 & Ui IR 24kl B i B
(clu_keepalive Fl clu_update /2.0 M I A & 213 [ 25 A8 PTG & () ORFRIE R R B, YO A
T15 3 20 Fh 2 [0) . BROMER 150 R80T BRARCRE [R] bR 12 8 EE BRI SE A InF 1], DADs /D AR
HBEE BT

* Cluster Control Link - ¥5 52 SE R il M 9% 1
* #0 (Interface) - f73¢ VNI #£11,
* IP Address- $i & IPv4 HuUlilEAE oy TP Huhik;  B03% AN S TPv6.
* Subnet Mask - $§ & - M HERS .

* MTU - $55& VTEP 4% O {5 K AL i Ay 22 /0 L B4 D i B MTU & 154 735, T4
T4 B B U e L B 0 A i, DR SR 42 1) 1 5 2 R A 2 M S0 3 /N P i £ DA 2
FERERETITAY (100 275) F1 VXLAN JFRY (54 775 o ¥ MTU $% b 1554 #9198 F745
Z A . ERIAMTU Jy 1554 545 48042 LR E 1500 I, FRAl T 50K 2 E 2 il B %
MTU % &N 1654; SAETE MW . @i, 7EM0H B, @15k MTU 24 9198 ¢
A1, DA AR T MTU nJ LU 9044, TSR 5 I ) ] LLBEE h 9198, B4
IFAEG P REFPRCE )38, A2 AT s AR B B SRR R EERE T
S E AR B, 1 e BT, SRS EEHT I SRR

| asa g



AsA g |

B =ssozarsssstansmnags

$HIB 4 ik Participatein ASA cluster & EHEIN AR
S5 LGN

REZfTRESEEFENENMANLE

ROTREARZE I A E R 0 (P B 1D (s TR & . IS IRBU IS ANE VLAN 7% 11 F
AT BEANBEN TR BERR IO B2 B E e T RO .

M REFEECE (Configuration ) > & & &8 (Device Management) > = /] F4HFIATH B4 (High
Availability and Scalability) > ASA £2% (ASA Cluster) > E£8HZ IE1TIR R I4$E (Cluster Interface
Health Monitoring).

e MR O, RO, RE AR, BRI 2R R OAE .

P PUIR AT SO DU 5 o 2 SR U/ ORI () A AT W B FIRAS T B, T AS A AT o I
WA 8 3 2 T i e R TR B T a8 SIS IR S O IEAE INANERRE o BRIAIS DL R, APy e
A AT IR DU 2 o

ROTREARZE A E L R O (P B 0D iR & . IS1PIRBU RIS ANE VLAN 70 F
PAT . RN SRR TR O B R B TR RS

MR AEAT AT SO (A s R R B 1 e B ASAL BRATHL B, SN
IEA RS A TR (BLE (Configuration) > & & &8 (Device M anagement) > = 7] AR 4
F 4% (High Availability and Scalability) > ASA &8 (ASA Cluster)) s IREAR RN O A L B
WA e AR S T o R ELC B T S R B P S, ST DU R R A IR BRSO e

FIR3 i BHEFMA (Auto Rejoin)iE iR, LLEESCAERL L REUBEREF I R A b i (14 8 50

FOFTIIABLE . X TRERRSRMY,  mithi s AR E LT 2L

s RAREIHMANEK RS - 0 A TR BT 0 3 65535 MM, & X FH I ANEREI 2R xS .
0K 2EH HahE B AN . KT, BRAEN Unlimited; X TEEEE ORI RS, BAEN
3,

s EFMANEPE - WL RENT 2 2] 60 FPITEFE, & PR EHIINN S22 18] (149 1] [ Fp S8 i ]
CLAA BN AL i%jwMEjj 5008 AR H I N1 5 R B TR B A B BRI
Z W 14400 43580 (10 ) &

* Interval Variation - i W B A1 1 23 BIAIRGAR A, & IARREFSIN TRE R EK: 1 O

2 CRIRFPEERTII) 265, B3 CRRFREEM TR 3 %) o filtur, i S AEHRE R) B FE 2 i () 15
h5orEh, IEMAREE S 2, WIFE S el E AT 1 {ﬁt%’éu& 7E 10 2080 (2 x 5) JEHEHATHE 2 Ik
ks 7E 20 2080 (2 x 10) JEHEATHS 3 WAk, SHFERED, RIMEAN L S TEdR RO R
g, ERNEA 2.

s E BCME LUK BOA B .

B AsasmmEsen
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L4 SN A.

FCE S 8F TCP S LR

oh TCP 342 5 AR S R A B T 2B IR G 5 ) 28/ 4 B v, AN B 5 e S 0t v A G 1)
CAMETAE” o TR, WA R OE T 0 S8/ A BE VAT B, T S X e
P e [RIRE, 0 o e O e I Ay P Sa i 2 A e &, WIJCVE RSB It . AN Ak

TCP BENLAL P& G TCP &I %ER .

UK

HIE1 EPRECE (Configuration) > % & &2 (Device Management) > & A] A4 F1 AT BB 14 (High Availability
and Scalability) > ASA &8 &l (ASA Cluster Replication).

P2 sl E LT E:
« SRR - BEME, JEEAT 1315 2.
* HTTP - W& T HTTP & 1 &R .
< R
o R - BCEUE IP M.
* Service- (JHE) Ve B GG o M & BB P ol F bR 1, TS 23 () 0 7
- BiR&H
R - WCE HFR IP Hudiks
« BRSS - (RIEE) BCHE Hobwoi o G R B B H AR, AN 2 R I R

$IE3 HE.
$E4 LN

fie & uh = (8] T BE
X AR, AT SR, LR LA AR b

=R S e 2
RS AR E NS AL RSB, ST LUK EE LISP WA LUR SRS B
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B xruseiem

&F LISP #&:7

KT LISP

ASA LISP 7 5

LISP #EN

ASA LISP 5Lt

AsA g |

FTLARGI A LISP ittt  DAEAE S, 8] R A s

AR PO BRI S (B, VMware VMotion) , R4 2% 0] DAEEHE O 8T8, [H K
YekF 52 i P& . O T SCRRISE S PO RS 2 B sl it B th 2% 75 BLAR T IR 25 28 B Bl ) B 3
MRS AN O EREA/ID 73 E Wi (LISP) ZEHK 1 25 B4 B 28 i AR AT (EID) 5 e 45
B EEE 1 E LT (RLOC) 35 TT, R BB AN g5 25 i), SRR G54 1T B 0% ) i 140375 B
o T, 2R G5 AITHR BIH 1k I L2 v 1) IR 25 2 AR T N, B R e 2 K U R T 1) BB
(A=

LISP 5 278 4 i A (1A % th 2 AR S5 2%, 40 LISP M 1B IE B th 88 (ETR) A LI BSIE B Hh 8%
(ITR). H—Bki% thas WU AENTEE (MR) FIBCES IR S5 25 (MS)o RS54 1) 5 — Bk % b 2 A0 380 IR 45
PR T HADES a0, ES R ALK 2 M 2, DUE &R 2R 7 i ITR AT LA
BRI B IR R R BB IR A AR A

ASA A B RIZAT LISP; {H/2, "Bnl LB K2 LISP S A E A B H ek, AR5 10T b fs BakAT g%
SETRERAE . A0SR LISP 4508, RSS2 B 8l B0 sl s I, 0K B2 T8l 557 (1) ASA £ET
B, AR AT A # . B ASAKEIR I R B IHEE 2 ASA, X5 IH ASADAZIUK it 2 & [F]
Bk, A RERNEMRS A . R BRI THRARE, B “KS57 o “Rr¥k” .

oA LISP 2%, ASA BN A nl LI & 58 —Bki% th 2% 5 ETR 8¢ ITR Z [8]f) LISP yii &, ARJ5
N ITAT A7 B T SR T A

* ASA TERER L A T2 — ki pH A8 Ak s ITR 58 ETR 2 [A]. ASA SEHEA G ANREIE LY
J R B 1) 5 — e % 1 4% o

 DOECFr e Al b Bl A AR s T AN R R R A 2 S 2R
T AN (Bl st Hob 4 SRS A 1A ASA I T 1
s RO NS 3 RS 4 ZW0IRAS; L AR T REE K.

o X T RSN RIS R B S AR S L 35 Bt i, BBl PTAT B TR ARl e . AR E A &
SIS, AR LAY L RESCRF It 2R, IR RO i 300 R AR A Zh 1k

UEDIRE R S ZMAH IR AL . (CARERIE — Uil -

1 (A3 JEFENUERS 2% 1P Mk BRI 72 1) BID - 28— Bk 8 nl g 23 i) 55 ASA R
FHLE ML k3% BID JWAITH S, Uk, Snr LR 1) 5 5 I AT A Q1 e 45 i 5 4 1%
EID. fltm, unSAEREA & 2 ANl s, (HJ& LISP 75 3 Ml i Bisdr, N R AFEERE &1 2
ANk S EID.
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2. LISP i EA A - ASA f 7 UDP i [l 4342 L) LISP i &2 H A& 5 — ki #2855 ITR 2 ETR
Z AR () BID S AN B . ASA 4335 — /¥ EID Al 25 ID MISCHEK EID £. filtn, S
AL 5 — Bk 25 TP bl DL TTR 5 ETR H brithhil i LISP & . WiER, ¥k LISP Jit
BN T LY, JFH LISP B A S AS HEIRE I,

3. HT A TRt m i sh T i I 55 SEms - 48 N e Bl 450t e R shvk . ltnn, sl AR
X HTTPS it & Fl/8l ki B4 i i 45w 9 &0 H R s ik .
4. Ui ID - ASA I SEFE AR REAN 1T s Rk 5 1D A e BT BT A
5. T AR ERERESONIC E - BB NI IE B ahtt. I/ o) ss R ir i
AR M T FH B AR s A e S FH 2R RS Bk
EL & LISP #30)
RS A AE G 2 RIS SN, 145 m] LUK A LISP i & LLS A shik

Fi&aZ 8
o FRIERCE LA ASA SIS H, 5621 W, AFMEREERSE Dl A 1D,

* LISP it i R 7E default-inspection-traffic 1, Pk, TR FE 242508 LISP it f i & A
AU SN

RS

$HE (k) FCE LISP A It DURYE 1P bk PRSI % EID, JHC'E LISP Tt =55 4H.

a) IKGEFELE > BhAME > W& > Mg > LISP,

b) A RN LA H A

c) MINLWR (BZ 40 NFRF) Mk .

d) XTRIEREIDFEYIER, HEEE.
A4 KT IF ACL Manager .
55—k 2S5 ITR/ETR ] RESS ] 5 ASA FEREIC IS LML M 4% 3% EID Gl 4y B, Kk, &
AT DABR I ) 5 A8 AR AT JC I AR SS 2 ak M 4% K 3% EID . i dn,  n SRAEREAG K 2 ANk i, (HAE
LISP 7E 3 ANl i Fig4y, W ARSI I 2 /N ) EID.

e) MR KBS & 5 s i 23 20—/~ ACE ) ACL.

f) WERTHE, WMAIIEZEA.

TR T A IS, 1 S B R Ak A .
g) MilifAE.
ISR 25 SR U DAC & LISP A6 -

a)  KIKEPEECE > B KIS > ARSS SRAE A .
b) iR,

N
5
N
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d)

e)
f)

2)
h)
i)
j)
k)

AsA g |

TERR S5 SRBE UTT b, KRNI N FH 2142 LB A4s Je B

U AT AT A IR S5 R, V8 SRS IR . BRAKE DL R, ASA BEFRA
global_policy {14 i Sk o A SIS B A Ja N SR, 38 ] DL RN 1B — AN IR 45 5k
W&o LISP Ar I 0 i) T T-o i, PRI BTG S e EUR H brdge 1 B Y F R85 Sms s n SRR
PN I BIEHBUCAS, DN SR AN FH R0 (4 11 0 BT At 52 5
ERENEEIN b, SEeIEFRER, ARERE RERAE M ETIRF B4R | Pl (E
A ACL).

M T—%,

fi e SR . AR UDP i 1 4342 B S BEEK tH 4555 ITR 2 ETR Z IR
$:% IPv4 fil IPv6 ACL.

M T—%,

TERMIRAE ) S I EE R b, SRR E R,

EH LISP Sk,

(i) i B E LA RE 6 2 R MR

et 58 B BA LR A IR 55 SR mes R ) o

SR NI ARG AN, D T EA S AR A S T

a)
b)
<)
d)

e)
f)

2
h)
i)
j)

KEPFELE > B A3E > BRSSSRBE AL .

raRhn.

TERRSSSRBG UL L, BT LISP R i) [ — IR 45 S

EmENEEN L, shtEFRESR, REenE RiEinE Nk iR B R | P k(5
F ACL).

MiET—%.

FRAEAE RS A% il i, BEEHT I B d R AL A e R . ildn, AT LI HTTPS
DR /BN R B R Ik A5 A I L i R 8 itk . #5652 TPv4 Rl IPv6 ACL.

MET—%.

FERUMIRAE ) T I BGE TR |, EPEERRETIR.

% BB LISPEID (2l A M ERRB ML M.

il 58 B ATRAE IR 55 SR m ) o

T4 RIEFERE > REEE > S BHEMA iR > ASA £ > £/ E, REETERERRBI
T4 AT I HE
$E5 N A.

Sk TN
EREMT S
HEERE G, AT LR O B A FE AR Y
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}\A*?%u ——Iﬁ_ll\\iﬁﬂu %ﬁ%—:&*ﬁ—-ﬁ_ll\\

R n] DUAF I ) SRR I A 2505 15 . T DM High Awailability and Scalability [/]- 551
HHE T m o IR A S IS 1 AR ALE T, R mT DA B AR T B o 12 B A I Y R B
P R BRSO B

s, AR AT DU SR BB 1Y ROF FLRAEIZ Y R B E AR . (FOR /e R 45, ASDM 231
ReWioTIER:, b PERE.
FiaZ |l

o GURAR I I B R Rk S | PRI, A CR A Y R R A R UG il 1 TP ik
UK

T KOEREE > REFEIE > SUAMAA B > ASA £8 > £8 A,
$£122 N Add.
$IE3 LELL NS5

* Member Name - i I ME— 1] ASCII ‘45 S G ILERE A i 4, KEEDIN 1 31 38 N7,

* BUSMASEER - BEE M R TR RS I E g, FHEVE R 180100, 3L 1 il
%o

* Cluster Control Link > 1P Address - Jy I 545 52 ME— AR RER I SRR TP Muht, L2t 42
RENEE vl s VA R R MRS S

* 7t Deployment Options [X 1%, MLULT Deploy By £ H ik £ — ML Tl :

* IBNENEFRIRE KIE CLI v - K55 | PR P RC E AL BB 1 i) iy 47 2E 1P bk,
i NKCHE 1 S B IP Mok, P A R

* BERE CLI FahEFIFHMMEITIZRE L - Ear4, LUE BT DI FERGG 20 15 50 CLI
R 7E ASDM ] CLI L HE. £ Commands to Deploy ZIEHEHT, I+ A K dr
A BER e AL

Deployment Options
Deploy By: | Copying generated CLI commands to paste on the remote unit manually

Commands to Deploy:

cluster interface-mode spanned force
clear configure cluster
interface GigabitEthermet(/4
no shutdown
cluster group clusterl
local-unit asalo
priority 2
cluster-interface GigabitEthernet0/4 ip 192.168.5.2 255.255.255.0
key test
enable as-data-node- neconfirm
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BhIEE A

A xll OK, AJs niddi Apply.

AR T =

BRI ARE S S, AR R AR, I IR AL

)

AR YASARTARNGESPIRE (LFEhI7 s IS RO 2RO I, B 8l DR el A
B g AT DUAE AN i SRR AR, WEEORT S AR s, S nT DOAEEREH 58
EMERIZAT R B LR ORFFST T, ALY RO ERTE TP iy 1P ik HA SRS H B 4,
M SRR A TAE T RES (B, frde T A HAERIICED o W BEE LR A .
R ZBUAE P 65 g R EEAT AR 8 — 2D C AL

UK

FIB KGEFRE > REEE > SWRAMT B4 > ASA 45 > BlE.
H1B2 HUNET AN ASA EBETHE,
R BN P BCE ASA SRR B S EME, WSS R AT R B M T B,
{45 ASDM IER R A B O . ZEdbiE ol B IER:, BT B EH 40 0 By
CLI,

PR3 LA

MEH T S EREET =
SRR A, LT 58

\)

AR YASAR T ARG, PR D O] R AR B AL DT DUACE MO . SRR
R, WA SRR B LR ORFFAT T, ALY RONERAE TP i 1P ik, (HAn R AR
WO, W SRR A T AR APIRZS (Biltn, st fifr 7T B2 AR ED BN
el S U P2 A & i ORI AR T 2D I IC AL

i

TR KOEHEE > REEE > SATRAMMAT R > ASA £
SR 2 EFEMER B Y R R A R RR
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sxmakz ]

Hyn 0 5 SRR B R ANAZ, DR AT TR Jm BRI Iz Bl 19 mm A 2 R

FE3 A

EFMAEE

B

i

T

ISR R T AN R B LA RO ), e R TR T AR, TR
LI T SRS

UK

WA ASDM Vi n), %] DUE K ASDM 42 21 ARE 50 o FHAERER T 5, £ ASDM HH 85T
AR

TEANBE N T BE A A B 1T A T A AR RE,  BRAEREZ R &8 0 kB 1 3

a) KIXEREE > REEIE > S AMEMAT B > ASA £8,

b) ErPADN ASA EEBEE M.

c) M.

WAREAGEAEH ASDM: 7Efll G b, FEAGRFIC B
cluster group name

T

ciscoasa (config)# cluster group podl

Ja FHEERE
enable

LR AR, MR AEAER | PR FRCE . TR S R S AT AR R OAN T e
25D, DAIMGR AR RRAT 2 A N A I R AT (L, 28 i R BT IR0 O F 0B T 46 i
PAAe IP kb 5.

iz

SR TR D DEE i

cluster group cluster_name no enable
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B

TP

ciscoasa (config)# cluster group clusterl
ciscoasa(cfg-cluster)# no enable

FERE Y R AR, STV AT e S e
WIR2 THERAETLE
clear configure cluster
ASA KR P A, ELFE G PR RIS I 5
T3 SRR DA
no cluster interface-mode
BT R TR E T, PRI T3 .
S WA ROIE, A O B I (AT RO
copy backup_cfg running-config
il
ciscoasa(config)# copy backup cluster.cfg running-config
Source filename [backup cluster.cfg]?

Destination filename [running-config]?
ciscoasa(config) #

BYRS RRCE DR AF B ST

write memory

FER6 WORBCAH A PBCE, THFORECE B . B, fROREE e TP ek, IR RS ENLA

EREHT R
A

ER RS A, ARV AT S AR, SRR I A S R R AR W
R E S RY ) U RART R WA R R . EURIRERL, AR IIRET S, W
FAE AR Py o S S w49 s WA SRR T T, i R b B T A a1 i BB i S

SR AL EPATEL R R

i

L1 KIRIEFE Monitoring > ASA Cluster > Cluster Summary.
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FHIE2 T 43R TP B R R P BT S B T T, ARG s LA R A A T
P 3 RGBT . A2,
HIE 4 B ASDM, ARJEAH 4 1P Hhhb d08TiE .

EENERSERAPITH S

S AT R AT T R BN E T AU AT S, T PATEL NP ER . m) P RUR A show i 4 LA
AR DT R R L B A i R AR S B T ARG N AT HoAt A4 (A capture
F1 copy)
FIRZ Bl

LEAT AT A TR P AT AL T K IRIEFSE Tools> Command Line Interface.

UK

FOEA BT R, BEEWUIRTEE T R AARK, WA BIRy E 5 A
cluster exec [unit node_name] command

T

ciscoasa# cluster exec show xlate

PEAE T ARR, WEEI cluster exec unit 2 Caf A B BR M AT Y A AN PTA ARR) . B show
cluster info fiy 4.

T
SR N 7]l RS AR (A R 2 TETP IR S5 a4, ARy sl A A LR
i

ciscoasa# cluster exec copy /pcap capture: tftp://10.1.1.56/capturel.pcap

Z A PCAP IUAF (AR B — 1 /D KRB TFTP ik55as. HFIRCIE 44 A3l
BN 44 HK, 10 capturel asal.pcap. capturel asa2.pcap 5. fEAHIF, asalflasa2 &%
HETT AR

Ik ASA Virtual &£ 8%

BT LU AR SMUE R HE R s
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| R

VR =: E ) HA
IR EERFINTS
IEE DI GGl S RN
© BS¥E > ASA R > RRIRE

SR T A% Sk s AT O B R A e USRI R AR SRR R o R0 mT AR L B o S S
Ko

* RS ER
FEE R T ITL, T DU PR A2 T T ASOMI AR 17 X e 2 1 T AR A B

HIRBENRECEE NS
A RAEERE TR B O AE R, ES LR bk
Wizards > Packet Capture Wizard

LSRRV R (R OB FR I A0nT ARSI st LS R e R e IR R I D e, B S SRR P (o
AT R R R e .

B>
PR
H3}
i
i
9

TH 2 LA B DL 2 SR T TR U -
* Monitoring > ASA Cluster > System Resour ces Graphs > CPU
ST R AT T G s T SR RE Y 1 CPU A A 1 B ek
- Wrim > ASA S8 > RGEEE > 7. HLEHG AT T 00 R T SR AT AR L P

FEIHEE.
HIERMNE

TS LT B DU P S R
* B54E > ASA £BE > REE > EE.
LB RS T T B s P A SR AR D R JET ek
« EE>ASA KB > REE > FHE.
Wb W] T G S s T AT SR A A 7 U B A ) P B
* B54E > ASA SEEERE > BEfA B INIR

KA R M E BRI SIS B A . RIS B R RT — HE SE
PR A, LU DR R R GRS T 0 30) o M G s IS S B T B
AP 5] 1) 5 1 A A
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T SR B I TR
ISR IO, ST R R
Wi > Bt > REARE > EEHEHISE
B 0 1T 7 B BERM 2 L TR R B

RAg Ak e get
A REREBR MG R, 1S B LUN bR
* W5 > BEH > LISP-EID %
78 ASAEID %, & 87 7 EID Al £{ ID.

BcE &R HEIEE
AR R, 5200 DL B
RE > REEE> 2% > REBSRE

wpanmnsn ]

SRR AR RO O A AR G H S R BT DR AR SR AT AR AN R 52 1D R S8 H A

K DI B Lk A ARAE P AOAR R A A4

ASA Virtual &£ 8 7= 151

XL % SR P R AT S ARG ASA E

J0 4% O R AR Eg AL uh B SR RF 71

LUR 7RG 21K 2 A ASA SRR s AL T 2 AN EEAE N B A T Eik h # 2 0) CREESAN) 15t

e ARAEY ROARTEIZ I BE BRI DCL IR AL TR Hdh w0 fK A AN A1 B % o 24 ] OSPF

H1PBR £ ECMP {EHAFE 1l 03 2 [P B AT S804 T . S 45 52 DCT H TR RS e R b m R

RSN LN BRARS ol i LRI ASASRIETS S rh Wrii ) o iR —Auli s BRI
AREY R A E W, RS BRI g8 1 DCIL AAE Sy — Nl i) ASA SRS .
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T
r/_ P N __\
E;\ Internet
Router e SRR g Router
S
Higher cost route f_,_fo
C QOutside )
-
Node3
Data Center
Interconnect
o
{  Inside ]
W gt
e Higher cost route Higher cost route
— .
Router

Data Center 1 Data Center 2
ESX

AR B RER TR RPN .

L\b kY +

ASA T FREERE

B> ASA ThREAZ ASA SRBESCRE, A0 DhReANAEFE w1 s b2 3 ke, oAt Dy R nT REXS 4] 1F

A AL e T = I,
SRR

LU DI REAE 3 FARBER IGO0 R ICVERCHE, ARG & A 4
* WKAE TLS ARBESEHLIN & — 5 T fg
* TRV VPN (SSL VPN il IPsec VPN)
o MEAUBEIERL T (VTI)
* LUN R TR #
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* CTIQBE

* H323. H225 fl RAS
* IPsec %%

* MGCP

* MMP

* RTSP

* SCCP (%) "3ifi)

* WAAS

* WCCP

o B g I DE RS

* ABNE BRSS9

* DHCP % /i g5 #s AAREL. S0fF DHCP 14k,
* VPN g5 1)y

* MRS

o SRR R

* FIPS 1 5

EERFEE L INAE
DL R Sh A (il 2 AR, BRI R .

)

AR AP D RE AT DA B T U L ST TR B e b B

WERAG I AR DI RE, U2 50K S vh Th e XU BRI 0 B AP U e, SRS PRI R U
AT IIRE: WUORAEIENE L, %R SRR A& [ R R

X DIRETT 5, WA Y R AW, T T SRR T T, S AR T AP i
HEATIER.

© DU MR A
* DCERPC
* ESMTP
* IM

* NetBIOS
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* PPTP
* RADIUS
* RSH

* SNMP
* SQLNET
* SUNRPC
* TFTP

* XDMCP

o WA R AR

o PREET 1) IR S 90 UEFIFZ AL o KA 2315
* i S5

* i filH] VPN

* AHE

N2 BT SR Th BE
IXSE T HERE N B BEAS ASA 1 A AR EE AN B nl s iy a5

* Q0S-QoS MK T & Z L FE b fE4RBEP R D . (B2, ZRME EAEREATY A B AT . 11
fr, TR R R, DU R S ASA R R I A5 R0 £ 3 2 RN 4 ) (R 5
. EEE 3 AN A B eI oA AR, FF AN ) SR AR R T SRR 3
i,
o SR - M AE BT S RS AR B, HER S RO A AR e . Ay ]
FIASI A, R KA A T R T s, AN A E BT T,
PR s 1 A v 1A
o PP B - 2N SR I B R A AR A A A R DA RN T AT
* LISP Jii & - UDP ¥ I 4342 /Y LISP i & (i &AM st fTie 2, (HIEEH A S )
2o BEANTT SRS INBIAERE LK) EID %, {HJE LISP i A B i AS SERRIRS IR,

T ®4&i71e) 8 AAA FEcRf

T BT ) AAA T =800 41: S RAE. SRBNCIK. SRR IE AU R D e fE 4R A
P i s, ELACH Ak SR B AR T e A SR IEAS AR AL B AR R
KT E R, ARSI AT 2 1 S0 Uk i BEAT HI P S AR 2y nk Az ey,
3 B0 IE AR 25 PR R 00 B I R DR P
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wmganes

PO AE A B S REAE SRR S o C KL AR R e i, RIIAE D I R e B G K, MR b i
B AR S A B AT IT Ua A 1B R A 3] AAA RS 2%

ERRETNEE
B SRR SRRV B RS (52 B & (Configuration)> B AIE (Firewall)> BR 5 55 #& (Service
Policy) TUIfiD o RN A ARYE T 3B B A TSRO R (T B . TR, e
i (1 3% 2 PRI T REAN 2 P e PR AR BB St e A0 s E AT AR 48 502 IR 0] 05 1 3 e 1 I A B
BRI T B de i . AN, ZE USRI, 25 20 B I 1) 17 B

MR FNERE
FERT B VRN, AN R A S BT () 5 HH B84 T B e RS0, FLAEAN T A 3R 6 e o
& 433 FE OB TR S H

Router A

All units are using OSPF
with neighboring routers

ECMP Load Balancing

w
2]
[22]
o
[+3]
(8}

Router B

fE LI, B lids A SR 4 5 AR IEAE R thds B, RESCEREMEL L — A1, ECMP I T
FEIX 4 AR 2 DR LR AT S0 M. BT AR S AN R sl A I, AR PR AN IR (¢ e 5%
ID,

TS50 4% th 28 ID BC B — AR, AEREAN T S E G B ) il 2 1D
EIGRP 5 FANE RS AR BET S AR AR AR 8 e 2R o
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FTP FN&Ef

AsA g |

\)

iR

WRAZIEIE N L BTCARA 2B 5 [ — A B e AR, AR RR B p Al RE 233 sloAN T 52 A
PR o BEREGARRI FREG ,  TERE FAT IX A8 i L A B ) — R DB o 3 2 [ I A X

© WIS FTP a8 TR 5 A JE A ph AN R O SR RS 3 AT DA B P AT 4 25 TR R I B
AL JVACE B S T T O SR A O N . (ERE U R EHT N 28 R B I S
FRE AR, WA TR/ TR R R R 2 R I A2

ICMPH& M AN EE B

ICMP F1 ICMP 4 i £ s ALl i SRR I T2 75 5 ICMP/ICMP &40 25 . AN g H ICMP £ £
i, ICMP &R, FHA RS8R JoH ICMP K A i, ICMP AR A XA, H 5 10 %/
B SR . WAL A ICMP 31— DA R 2 AR TE T 5 ) B0 R B B I A 3. 3 ) 28 2544 ICMP
(R 7 8 2 e 3 I 4 T A o, T AN S b B IR M1 25 5 R 2%

‘HIBEE R FnEERE

NAT FO&Ef

FERRST A TSR, B AN AR A AR . A Al A et o 500 G # eh P i BE e HEAT AR BRI 2
NITpEER A EITRa N =R B

NAT W 2 S RE N S A B e NS il NAT ¥ 4 il ol A 26 BIEERE R ASIE] (1K) ASA, R4
I AL T TP bR 1, NAT 2 S BN G A H 5550 6 B AN A 1) TP ik A/l 1. 24
Hn L RIA AR NAT Jr a5 1) ASARY, St R dliE i % R 2T, SRR SR
R RNERE. R, SO SISO ITE & W R, ) NAT I & ] e s
R 2 A R SRS, 7 45 T 0 $5d 0 B s i

W AR AT REAEAR T AT NAT, 355 B LA R vEN:

o AMEFACHEL ARP - X781, U120l s i thohk A AR BE ARP (R4 . 3 n) LAR 1E4R B th
WENRECAANLEEREP Y ASA (REF SRR XHFHe 1A AR 1P Shbk g m s bl F 3y
FH 2 T L A I b B 0 S ER BRI PBR. IX X015 /9 2% EtherChannel SR B A & ) #, PRI AT —
A TP Hhk 5 AR 1 OCHE .

o ANKPPSTE U 92 11 PAT - B57.3% AR5 11 PAT.

* PAT X3 N HRIMHE - TS B iZ DD RERT LA T AEN -

o BEEHUR LR BRBIFAE AN ERAE, Mt S ] TR Rl A, AEREERLR K
BRI E A 1A 3 AN SRR, WURAEAHE 3 AN sl B ok B LA A & s
P, WIRTLLP I 3 AN B, BRI RLT A

o FESRATRE TN LB R B BRI, 752 it v A 48 01 st B 1 s VRN SR A
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o AR HEAT RN PAT HEMMETS O PAT St 4B i 1P M hEJE D, 2 S BRI A
I AT A i ) B A5 T8 473 348 SR A oA RS R0 AT A I A L B BE D BE TR AT
e MG E PAT i, R BT ARSI 1Y R 2 18] 7 POt R AT 77 8 1 (1 A
fHIE

© FESRRE RIS, ANREEE SRR/ R RSP BRI B, BiR
AINA AR i ET MBS, BT BN R AT B2 IO 37 B K e A
WAHSG RO AT e e SR, R mT AT SCBR R/ I 00T G el e o e R

o XFZhA PAT ] NAT jthHiht 73 Ac - B & PAT Ml , SEREEIB A AR TP HudikRI 43 g i 1 B
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